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So, you just started your own small business. You have established a brand, albeit 
small, but you have managed to get together your colors and fonts. The next thing 
you want is to create a corporate website and brochure.

For the website, you are just going to use a web hosting company that offers the 
service and drag and drop to build. But, for the corporate brochure, what do you do?

Should you hire a freelance designer? 

No, you want to do this yourself as you have design ideas of your own.

You look around on your laptop to see what applications you have that you could 
use for a brochure design.

Excel, no. Word, maybe. PowerPoint…hmmm…

You already have some experience in PowerPoint presentation design. But can you 
design a corporate brochure in PowerPoint that looks like it came from an industry 
standard design application like Adobe InDesign?

The answer is yes!
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did you know
500
MILLION PEOPLE
use PowerPoint

Over

300
MILLION PRESENTATIONS
are created each day

PowerPoint is the most used presentation software across all age groups, 
with 3.4 million 16–24-year-olds and a third of those over 55 having used it.

About

PowerPoint has a

23.93%
market share

in the
presentation market

Canva

44.55%
Scribd

9.81%
Prezi

5.43%
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Setting up your document

CHAPTERS

Adding a color palette Embedding your fonts Adding images to your layout

Making a gradient fill Adding and styling your text Creating custom line spacing Adding a drop shadow to a shape

1 2 3 4
5 6 7 8
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First, you will need to setup the PowerPoint document in the correct format. Assuming you are in the United States, 
the common format and size would be letter or 8.5 in (tall) X 11 in (wide).

Step 1Step 1
Open PowerPoint and go to the Slide Master.

Step 2Step 2
Click on the Slide Size button and click on Page Setup.
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The ISO 216 standard, which includes the commonly used A4 size, is the international standard for paper size.1

Step 3Step 3
Once there, change the current size to 8.5 in and 11 in.

The press Ok.

Step 4Step 4
You will get an alert about scaling content; you don’t 
need to be worried about this. Just press Scale Up.

did you know...

1. https://en.wikipedia.org/wiki/Paper_size

https://en.wikipedia.org/wiki/Paper_size
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It (A4) is used across the world except in North America and parts of Central and South America, 
where North American paper sizes such as “Letter” and “Legal” are used.1

Step 5Step 5
The document will now be in the correct letter 
size needed.

Close the Slide Master.

Step 6Step 6
You can delete any template or pre-added content that is 
on the document as you will not need it.

You now have a blank document to begin your design.

did you know...

1. https://en.wikipedia.org/wiki/Paper_size

https://en.wikipedia.org/wiki/Paper_size
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Now that your document is created,
let’s start learning and designing!
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Here is what we will be designing 
in PowerPoint. This was originally 
done in InDesign.

Let’s take it apart and see how 
to achieve this in PowerPoint.
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To begin, let’s establish the color palette you will be using in the design. Below is the color palette we will be using. 
Hexadecimals are included.

Green
#3baf29

Blue
#2da7d3

Yellow
#f69533

Purple
#8f4396

Light Gray
#818285

Dark Gray
#414141
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There are a few ways to add colors to PowerPoint, but we are going to our color palette as the ‘theme’ to this design.

Step 1Step 1
Go to the Design tab.

Step 2Step 2
Click on the arrow to bring up more options in the theme section.
Go colors section, then to the Customize Colors at the bottom.
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Around 1665 Isaac Newton used a prism to turn white light into a rainbow and identified seven colors. He felt the 
last color, indigo, was a recurrence of the first color, red and decided to arrange the colors in a circle.1

Step 3Step 3
Add the color palette to the color selections available. 
If you must repeat a color, that’s fine.

Step 4Step 4
Name your theme, and you’re done!

did you know...

1. https://www.designpoolpatterns.com/10-fun-facts-about-color/

https://www.designpoolpatterns.com/10-fun-facts-about-color/
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Custom Fonts
Now that the color palette has been added we will address the 
use of custom fonts in PowerPoint.

Generally, in the business world, most PowerPoints use a 
common font – such as Arial, for their presentations. That’s 
because, it’s on just about everyone’s computer and no further 
action other than using the font is needed.

In the case of a corporate brochure, you would want to keep 
your font(s) consistent with your branding guidelines. The good 
news is PowerPoint will let you do that. You will need to embed 
your fonts for them to work. This is a good idea to do once you 
have added text to your layout.



Design in PowerPoint like InDesign | 14

Embedding your fonts

Step 1Step 1
Go to Preferences

Step 2Step 2
Click on Save
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Consistent use of a specific font can increase brand recognition by up to 80%.1

Step 3Step 3
Click the checkbox to embed the fonts and choose to 
embed all fonts.

did you know...

1. https://www.linearity.io/blog/font-statistics/

https://www.linearity.io/blog/font-statistics/
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Images and Graphics
Let’s begin the layout of the brochure. First, we will add the logo.

When adding vector graphics such as .eps, or .ai formats, it is 
best to try to convert them to .svg formats. SVG’s can be converted 
to PowerPoint shapes and become a native format that can be 
customized within PowerPoint, i.e. colors, shape editing, etc.
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Adding images to your layout

Step 1Step 1
Go to Insert tab

Step 2Step 2
Click on Picture, then Picture from File
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Photoshop is the most popular graphic design software with a market share of 43.8%.1

Step 3Step 3
Browse to find the image you want to insert.

Step 4Step 4
Add and size the image as needed in your layout.

did you know...

1. https://colorlib.com/wp/graphic-design-statistics/

https://colorlib.com/wp/graphic-design-statistics/
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Gradients
Next, lets add the top gradient strip.

Gradual transitions between different hues make it look like 
the palette is richer than it really is. By using a gradient fill, 
you can instantly add volume to your shape and turn it into an 
attention grabber. This is especially helpful when designing 
shapes that are supposed to catch a user’s eye.
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Making a gradient fill

Step 1Step 1
Go to the Insert tab, then to shapes and select the 
square shape

Step 2Step 2
Draw the rectangle at the top of the document.
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Types of gradients include: linear, radial, angular, diamond, mesh, shape blur, freeform, multiple

Step 3Step 3
Next you will need to format the shape.

Right click on the shape to bring out the menu and select 
Format Shape.

Step 4Step 4
If it’s not already visible, the format side bar should 
appear to the right.

did you know...

1. https://blog.icons8.com/articles/types-of-gradients-and-how-to-use-them/

https://blog.icons8.com/articles/types-of-gradients-and-how-to-use-them/
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You can add gradients to mimic various lighting effects and create magical visual effects.

Step 5Step 5
Select the fill as a gradient and remove the line.

If the default gradient doesn’t have the green to start 
with, you can adjust that with the Direction setting.

Step 6Step 6
Start changing or adding the colors for the gradient. 
To add color stoppers, just click on the gradient.

did you know...

1. https://blog.icons8.com/articles/types-of-gradients-and-how-to-use-them/

https://blog.icons8.com/articles/types-of-gradients-and-how-to-use-them/
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Gradients in graphic design date back to the 1880s when Jules Chéret introduced a brand-new printing method 
— three-stone lithography. It made printing with color possible and even allowed for subtle color blending.

Step 7Step 7
Once you have added all the stoppers/colors, your 
gradient is complete!

did you know...

1. https://blog.icons8.com/articles/types-of-gradients-and-how-to-use-them/

https://blog.icons8.com/articles/types-of-gradients-and-how-to-use-them/
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Text and Style
Let’s begin to add the text to the layout. 
Start with the headline.

A font style refers to the specific design and appearance of 
characters in a typeface. It encompasses various attributes, 
such as the shape, weight, spacing, and decorative elements 
of the letters. Font styles play a crucial role in visual 
communication by conveying a particular mood or conveying 
a message effectively. Fonts can give visual clues about the 
order a document should be read in and which parts are more 
important than others.1,2

1. https://owl.purdue.edu/owl/general_writing/visual_rhetoric/using_fonts_with_purpose/index.html
2. https://www.lenovo.com/ph/en/glossary/what-is-font-style/

https://owl.purdue.edu/owl/general_writing/visual_rhetoric/using_fonts_with_purpose/index.html
https://www.lenovo.com/ph/en/glossary/what-is-font-style/
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Adding and styling your text

Step 1Step 1
Go to the Insert tab, then Text Box

Step 2Step 2
Type or paste in your text.
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Around 70% of Fortune 500 companies use sans-serif fonts in their logos.1

Step 3Step 3
Next you will need to change the default font style to your 
brand font.

Go to the Home tab, select the text and change it to the 
desired font face…in this case it is Franklin Gothic Heavy.

Step 4Step 4
Now that the font face has been changed, the characters 
need to be condensed to look like the example. 

did you know...

1. https://www.linearity.io/blog/font-statistics/

https://www.linearity.io/blog/font-statistics/
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The global font market is projected to reach over $4 billion by 2025.1

Step 5Step 5
Highlight the text and go to the character spacing button. 

Once there select More Spacing.

Step 6Step 6
Here you can expand or condense text. In this case we want to 
condense the text some.

Change the spacing to Condensed.

did you know...

1. https://www.linearity.io/blog/font-statistics/

https://www.linearity.io/blog/font-statistics/
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Google Fonts are used on over 50 million websites.1

Step 7Step 7
Condense the text by 0.8 points.

Change the kerning to 12 if it’s not already.

Step 8Step 8
You text should now match the example.

did you know...

1. https://www.linearity.io/blog/font-statistics/

https://www.linearity.io/blog/font-statistics/
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To achieve a specific spacing above and 
below a line of next, besides just using the 
enter/return key, you can do the following.

Let’s continue to add some text 
and graphics to the layout until 
you get to this point
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Creating custom line spacing

Step 1Step 1
Let’s start with the second header in the text column. 
Highlight the text.

Step 2Step 2
Go to the Line Spacing button, then Line Spacing Options.
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For optimal reading speed on the web, keep fonts at 10 points and above. Arial, Verdana, Georgia 
and Times New Roman all do equally well as far as reading speed goes.

Step 3Step 3
For this instance, change the spacing to 6pt for Before 
and 4pt for After. Then press Ok.

Step 4Step 4
Do the same for the first header, except don’t add any Before 
spacing…just the After spacing.

did you know...

1. https://creativemarket.com/blog/10-fascinating-scientific-facts-about-fonts

https://creativemarket.com/blog/10-fascinating-scientific-facts-about-fonts
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Now, let’s add the sidebar 
with a drop shadow.
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Adding a drop shadow to a shape

Step 1Step 1
Draw the shape, fill it with white and have no line. 

Move to the effects tab.

Step 2Step 2
Select the desired drop shadow direction.

With this, choose Outer, Offset: Bottom Left.
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There are three types of drop shadows: glow, flat, and perspective.1

Step 3Step 3
Next change the transparency and blur.

did you know...

1. Source

https://product.corel.com/help/PHOTO-PAINT/540240626/Main/EN/Doc/wwhelp/wwhimpl/common/html/wwhelp.htm?context=Corel_PHOTO_PAINT_Help&file=CorelDRAW_Adding_drop_shadows_to_objects.html
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The only things left to add to the 
layout are the footer and background 
color at the top.

Now take what you’ve learned so 
far and add the text and graphics 
to the side bar. Your layout should 
then look like this.



Design in PowerPoint like InDesign | 36

Adding the finishing touches

Step 1Step 1
Draw the shape, fill it with the lighter gray in the theme 
swatches.

Step 2Step 2
Drop the transparency to 90%
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If you have visual graphics, 85% of people are attracted to your brands.1

Step 3Step 3
Next send the box to Back.

Step 4Step 4
Add the footer. Use the second swatch as the background color.

Add the web address and copyright to the bar.

did you know...

1. https://learn.g2.com/graphic-design-statistics

https://learn.g2.com/graphic-design-statistics
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That’s it! You’ve successfully created 
a brochure in PowerPoint
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About Exact Market
Founded in 2007, Exact Market is a woman-owned, WBENC-certified business focused 
on unifying marketing and sales around a shared vision to successfully launch your 
new and existing offerings.

Our F500 clients are diverse and top-tier in their markets, and they look to us to help 
them differentiate and win. With a global focus, our professional team of strategists, 
marketers, sales experts, writers and designers can quickly provide custom and unique 
perspectives, content, and assets that set you and your solutions apart. Our flexible, 
scalable team, fully cloud-based services, and innovative remote workplace style enable 
us to scale when your projects are under deadline. We are more than a marketing firm, 
we are your valued partner and an extension of your team. We can help you design 
winning strategies–and then help you execute them flawlessly.

Exact Market exists to create comprehensive solutions that will empower your brand, 
unify relationships, and maximize your ROI.

Exact Market is a woman-owned,  
WBENC-certified business
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